
UPGRADING TO STRM 
RELEASE 2010.0 MAINTENANCE RELEASE 2
DECEMBER 2011
This document provides information on upgrading to STRM 2010.0.r2, including:

• Before You Upgrade

• Upgrading Appliances to STRM 2010.0.r2 Using CentOS

• Clearing the Cache

• After You Upgrade

Before You 
Upgrade

Before you upgrade, review each of the following sections:

• Impact of Upgrade on Your Data

• Upgrading Your Tuning Template

• Upgrade Requirements

• Pretesting Your System

• Preparing to Upgrade 

Impact of Upgrade on
Your Data

This section only applies to you if you are upgrading from STRM 2009.2 to STRM 
2010.0.r2. If you are upgrading from STRM 2010.0.r1 to Maintenance Release 2, 
you do not need to read this section.

Upgrading to STRM 2010.0.r2 provides significant improvements to Security 
Information and Event Management (SIEM) and network monitoring functionality. 
STRM 2010.0.r2 merges log and flow data using visualizations, rules, and 
offenses. Because the changes are extensive, the upgrade process removes any 
data that is no longer required by STRM. 
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CAUTION
Once an upgrade is in progress, data marked for removal during the upgrade 
cannot be recovered. 

The following table specifies the data and functionality changes that occur during 
the upgrade process:

Table 1-1   Upgrade Impact on Data 

Feature
Maintained in 
STRM 2010.0.r2? Description of Changes

Sentries No STRM 2010.0.r2 replaces sentry functionality 
with Anomaly Detection Rules, adding the 
following rule types:
• Threshold
• Behavioral
• Anomaly
Custom sentry alert information is not available in 
STRM 2010.0.r2. Before upgrading to STRM 
2010.0.r2, we recommend that you back up the 
following sentry items:
• Sentry data
• Sentry settings
• Sentry user roles
For more information on backing up your data, 
see the STRM Administration Guide.

Custom Views No STRM 2010.0.r2 replaces custom views with 
enhanced charting functionality in the Network 
Activity interface. We recommend that you 
recreate your custom views using the Network 
Activity interface in STRM 2010.0.r2.

Active 
Offenses

Yes During the upgrade process, active offenses are 
transitioned to the inactive (closed) state. 
Note: In STRM 2010.0.r2, you can search for 

and view closed offenses using the offense 
search feature. Closed offenses are available 
until offense retention period has elapsed. 
The default offense retention period is 3 days. 

Dashboard 
Customization

Yes Existing custom dashboard items from STRM 
2009.2 are still available in STRM 2010.0.r2.
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Custom Rules Yes, depending 
on the selected 
tuning template 
option.

STRM 2010.0.r2 provides new and updated 
common, event, and flow rules. The upgrade 
process maintains rule data according to the 
tuning template option you selected. For more 
information on the tuning template options, see 
Upgrading Your Tuning Template.

Network 
Surveillance

No  STRM 2010.0.r2 removes the Network 
Surveillance interface. Network surveillance 
functionality is now provided in the Log Activity 
and Network Activity interfaces.
In the Network Activity and Log Activity 
interfaces, you can configure time series 
searches to display time series charts with your 
search results and on your Dashboard interface. 
Data related to network surveillance is no longer 
available. Before upgrading to STRM 2010.0.r2, 
we recommend that you back up your network 
surveillance data. For more information on 
backing up your data, see the STRM 
Administration Guide.

Saved 
Searches

Yes, depending 
on the selected 
tuning template 
option.

We recommend that you evaluate the tuning 
template options before upgrading to determine 
how the tuning template options affect your 
saved searches. For more information on the 
tuning template options, see Upgrading Your 
Tuning Template.

Flow and 
Event Log 
Data

Yes Flow and event log data captured in STRM 
2009.2 is available in STRM 2010.0.r2.

Network 
Anomalies

No STRM 2010.0.r2 replaces network anomaly 
functionality with anomaly rules in the Rules 
interface of the Log Activity and Network Activity 
interfaces.
The Network Anomalies option is removed from 
the navigation menu in the Offenses interface.

Generated 
Reports

Yes, depending 
on the selected 
tuning template 
option. 

We recommend that you evaluate the tuning 
template options before upgrading to determine 
how the tuning template options affect your 
previously generated reports. For more 
information on the tuning template options, see 
Upgrading Your Tuning Template.

Table 1-1   Upgrade Impact on Data (continued)

Feature
Maintained in 
STRM 2010.0.r2? Description of Changes
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Report 
Templates

Yes, depending 
on the selected 
tuning template 
option.

Time series and TopN Time Series charts are 
removed from the Reports interface; therefore, 
reports based on these chart types are no longer 
available.
We recommend that you evaluate the tuning 
template options before upgrading to determine 
how the tuning template options affect your 
report templates. For more information on the 
tuning template options, see Upgrading Your 
Tuning Template.

Remote 
Services and 
Networks

Yes Remote Services and Remote Network groups 
created in STRM 2009.2 are still available in 
STRM 2010.0.r2.

Application 
Signatures

Yes Application mappings and signatures are 
available in STRM 2010.0.r2; however, you can 
no longer add custom applications using the 
STRM interface. You must manually add your 
custom application mappings to the configuration 
file. For more information on configuring your 
application mappings, see the STRM Application 
Configuration Guide.

Asset Data Yes All asset data is available in STRM 2010.0.r2, 
including port and vulnerability data.

Asset Map No The Asset map is no longer available in STRM 
2010.0.r2.

Deployment 
Editor

Yes The Flow View tab no longer exists in the 
deployment editor and its functionality is 
incorporated in the Event View tab. Pre-existing 
deployment configurations are converted for use 
with STRM 2010.0.r2.

Table 1-1   Upgrade Impact on Data (continued)

Feature
Maintained in 
STRM 2010.0.r2? Description of Changes
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Branch 
Filtering

No New load balancing and flow routing capabilities 
replace branch filtering in STRM 2010.0.r2.
If your previous deployment was configured for 
branch filtering, you must reconnect the QFlow 
Collector to Event Collectors using the 
deployment editor.
Note: STRM 2010.0.r2 introduced a new flow 

communication protocol, changing the way 
components communicate. We recommend 
that you upgrade all systems in your 
deployment to STRM 2010.0.r2; however, if 
you do not upgrade systems in your 
deployment hosting off-site flow sources, 
additional configuration is required. For more 
information, see the Configuring Flow 
Forwarding From Pre-2010.0.r2 Off-Site Flow 
Sources appendix in the STRM 
Administration Guide.

Appliance 
Migrations

Yes Flow Processor software components, including 
the Classification Engine and Flow Processor, 
are migrated to the Event Collector and Event 
Processor in STRM 2010.0.r2.

User Role 
Definitions and 
Permissions

Yes User role and permission data is maintained. The 
Manage User Role window has been updated to 
allow you to manage the permissions for new and 
updated functionality in STRM 2010.0.r2.

Custom Event 
Properties

Yes, depending 
on the selected 
tuning template 
option. 

We recommend that you evaluate the tuning 
template options before upgrading your system. 
For more information on tuning template options, 
see Upgrading Your Tuning Template.

Qualys 
Vulnerability 
Scanners

Yes Qualys scanners using Import -Technical 
Report as the collection type are converted to 
the new collection type Scheduled - Technical 
Report. For more information, see the Managing 
Vulnerability Assessment Guide.

Table 1-1   Upgrade Impact on Data (continued)

Feature
Maintained in 
STRM 2010.0.r2? Description of Changes
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Upgrading Your
Tuning Template

This section only applies to you if you are upgrading from STRM 2009.2 to STRM 
2010.0.r2. If you are upgrading from a previous STRM 2010.0.r2 to Maintenance 
Release 2, you do not need to read this section.

STRM 2010.0.r2 provides significant changes to the way rules and reports are 
stored. During the upgrade process, you are prompted to select one of four tuning 
template options. The options are described in the upgrade script; however, we 
recommend you carefully evaluate the following tuning template options before 
you begin upgrading your system:

 1 Reset the system to the default security template. 

This is the recommended option because it ensures the cleanest set of rules for 
your system. The system is reconfigured to factory settings. 

This option:

• Maintains all your data, including offenses, events, flows, assets, and reports. 

• Removes all previous rules, report templates, saved searches, and system 
tuning. 

We recommend that you recreate any custom rules, searches, and reports and 
then retune the system, if necessary.

 2 Apply the new default template and maintain the existing configuration. 

This option:

• Enables new default rules and time series accumulations without modifying any 
existing rules or searches.

• Maintains all your data, including offenses, events, flows, assets, and reports. 

System 
Settings

Yes The following system settings are no longer 
available in STRM 2010.0.r2:
• Asset Profile Views
• Database Storage Location
• Sentry Database Location
• Dynamic Custom View Deploy Interval
• Database Settings - Network View Graph 

Retention Period
• Database Settings - All Views - Group 

Database Retention Period
• Database Settings - All Views - Object 

Database Retention Period
• Ariel Database Settings - Custom View 

Retention Period

Table 1-1   Upgrade Impact on Data (continued)

Feature
Maintained in 
STRM 2010.0.r2? Description of Changes
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• Provides all new reports and accumulations.

• Resets all modified default reports to the default state, overwriting any 
customization. 

• Maintains all custom-created reports. 

Selecting this option introduces duplicate rules, because the system contains both 
existing and new rules. 

We recommend that you:

• Review your system for duplicate rules and building blocks that may cause 
false positive offenses and tune your system accordingly. 

• Recreate reports that require time series data using the new time series data 
options.

 3 Apply the new template and maintain the current configuration, while enabling only 
new flow rules, common rules, and specific event rules that are required for new 
reports. 

This option:

• Maintains all your data, including offenses, events, flows, assets, and reports. 

• Maintains all new reports and accumulations.

• Configures all modified default reports to the default state, overwriting any 
customization. 

• Maintains custom-created reports. 

• Maintains existing rules and saved searches.

• Enables flow rules that detect activity from flow data that was removed during 
the upgrade process.

We recommend that you:

• Review all common rules and enable the rules you want to use for flow-based 
analysis. 

• Review your system for duplicate rules and building blocks that may cause 
false positive offenses and then tune your system accordingly. 

• Recreate reports that require time series data using the new time series data 
options.

 4 Apply only the new rules and enable a minimal set of these rules.

This option:

• Maintains all your data, including offenses, events, flows, assets, and reports. 

• Maintains all existing reports.

• Prevents installation of new default saved searches and reports. 

• Maintains existing saved searches and reports. 
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We recommend that you:

• Review newly installed common rules and flow rules that are disabled by 
default, and enable the appropriate rules. 

• Review duplicate rules and building blocks that may cause false positive 
offenses and then tune your system accordingly.

• Recreate reports that require time series data using the new time series data 
options.

Upgrade
Requirements

Before you upgrade, you must verify that your deployment meets the following 
requirements:

• To upgrade to STRM 2010.0.r2, you must be running STRM 2009.2 build 
190775, including the latest patches. If you are not running at least STRM 
2009.2 build 190775, download and install STRM 2009.2 and patches from the 
Juniper customer support website. In the STRM user interface, click Help > 
About to view your STRM version information.

• Close all open STRM sessions to avoid access errors in your log file.

• Appliances cannot upgrade if they do not meet the minimum memory 
requirements, as specified in the following table: 

• Regardless of appliance type, we recommend that all systems running an 
Event Collector or Event Processor include a minimum of 8 GB of memory.

• We recommend that you upgrade all of the systems in your deployment from 
STRM 2009.2 to STRM 2010.0.r2. If a QFlow Collector does not meet the 

Table 1-2   Appliance Memory Requirements 

Appliance Minimum Memory Requirement
STRM 500 QFC 1 GB
STRM-QFC-BSE; 
JN-LG-STRM-QFC-BSE

2 GB

QFlow 1202 4 GB
QFlow 1301 4 GB
QFlow 1302 2 GB
QFlow 1310 4 GB
STRM 2000 8 GB
STRM 2500 8 GB
STRM 5000 8 GB
STRM 3105 8 GB
STRM 5000 EP; 2500 EP 8 GB
STRM 1605 8 GB
STRM 2500 FP 8 GB
STRM 2500 EP/FP Combo 8 GB
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minimum memory requirements or is unable to be upgraded, you must add the 
QFlow Collector as a Pre-2010.0.r2 Off-site Flow Source. For more information 
on adding flow sources, see the STRM Administration Guide.

• The Java Runtime Environment must be installed on the desktop system you 
use to view STRM. You can download Java version 1.6.0_u24 at the following 
website: http://www.java.com.

• Adobe Flash 10.x must be installed on the desktop system you use to view 
STRM.

• The upgrade process validates the disk space required for your STRM 
configuration and determines if enough disk space is available. If your system 
does not have enough free disk space, the upgrade process stops and a 
message appears warning you that additional disk space is required to perform 
the upgrade. The STRM 2010.0.r2 upgrade requires the following minimum free 
disk space:

- The / partition must have at least 3 GB of free space.

- The /store partition must have at least 4 GB of free space. 

- The /var/log partition must have at least 500 MB of free space.

- The /store/tmp partition must have at least 800 MB of free space.

Pretesting Your
System

Before you upgrade to STRM 2010.0.r2, you must perform a pretest on all systems 
in your deployment to ensure that your deployment meets the requirements for the 
upgrade. We recommend that you schedule the pretest during non-peak hours.

To pretest your system:

Step 1 Log in as root. 

Step 2 Choose one of the following options:

a    If your system is running CentOS, go to  Step 3.

Step 3 Download and mount the STRM 2010.0.r2 software:

a    To create the /store/iso folder:
mkdir /store/iso

b    Go to the Juniper customer support website to access the STRM 2010.0.r2 
download: 
www.juniper.net/support/

c    Copy the file to the /store/iso folder on your system. 

d    To mount the ISO: 
mount –o loop /store/iso/<ISO-filename> /media/cdrom 

e    Go to  Step 4.

Step 4 To perform the pretest:
/media/cdrom/setup -t

The following message appears:
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About to run pretests in preparation for upgrade from version 
2009.2.<Build version> to 2010.0.r2<Build version>

Do you wish to continue (Y/[N])?

Step 5 Type Y to continue the pretest.

The pretest may prompt you to delete patch files that are no longer required by 
the system.

The following message appears:
WARNING: This release offers new and updated functionality that 
results in a change to our data collection process. Upgrading 
your system will result in some data (as defined below) being 
removed from your system. Removed data cannot be recovered once 
the upgrade is in process and will no longer be available by the 
system. If you require this data, back up the data before 
continuing with the upgrade process.

The upgrade will remove the following data:

- Sentries: /store/sentry that uses XX(K/M/G) of disk space. 
- Network Surveillance Views: /store/db that uses XX(K/M/G) of 
disk space.
- Offenses: Current offenses will not be lost during the 
upgrade, however all open offenses will be closed. 

For more information, see the Upgrade Guide and Release Notes.

Are you sure you want to proceed with the upgrade (Y/[N])?
NOTE: Data will only be deleted when you perform the upgrade.
Press ENTER to continue the pretest.

Step 6 Press Enter to continue.

CAUTION
When pretesting your system, you are prompted to run PRETESTDOWN scripts 
after the initial Pretest is complete. The PRETESTDOWN scripts require all 
services to be stopped to test the integrity of the database, resulting in a data 
outage. 

The following message appears:

Completed all PRETEST scripts successfully.
**************** WARNING ******************
About to run PRETESTDOWN scripts which will cause tomcat and 
hostcontext services to be stopped and cause a data outage. 
These test scripts will be run:
check_db_upgrade.sh
check_permissions.sh
*************** WARNING *******************
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Proceed (Y/[N]) (default to N after 55 seconds)? 
Are you absolutely sure? THERE WILL BE A DATA OUTAGE!
Proceed (Y/[N]) (default to N after 50 seconds)?

Step 7 Type Y to run the PRETESTDOWN scripts.

The output of the pretest determines if your system meets the upgrade system 
requirements, such as:

• Memory requirements

• Partitioning

• Supported and required RPMs

• Log source limits

• Licensing

• Out of memory notifications

• Disk sentry notifications

• Invalid passwords

• Failed logins

• PostgreSQL issues

• Table constraint/key issues

Third-party RPMs are not supported on STRM systems. If the pretest discovers 
unsupported RPMs, remove the unsupported RPMs before upgrading your 
system. If the pretest discovers that required RPMs have been removed, you must 
reinstall the required RPMs before continuing with your upgrade.

If the pretest indicates a problem, contact Juniper customer support.

Preparing to Upgrade You must complete the upgrade process on your STRM Console first and you 
must be able to access the STRM user interface on your desktop system before 
upgrading your secondary Console other systems in your deployment.

Any QFlow appliance with less than a 80 GB hard drive must use a fresh 
installation to use the latest software. For more information, see the STRM 
Installation Guide. 

STRM 2010.0.r2 introduced a new flow communication protocol, changing the way 
components communicate. We recommend that you upgrade all systems in your 
deployment to STRM 2010.0.r2; however, if you do not upgrade systems in your 
deployment hosting off-site flow sources, additional configuration is required. For 
more information, see the Configuring Flow Forwarding From Pre-2010.0.r2 
Off-Site Flow Sources appendix in the STRM Administration Guide.

If your deployment consists of a software-based (non-appliance) installation and 
you have questions concerning your deployment, contact Juniper customer 
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support for assistance. For information on STRM appliances and hardware, see 
the STRM Hardware Installation Guide.

You must upgrade your STRM systems in the following order:

 1 Console

 2 The following systems can upgraded concurrently:

• Event Processors

• Event Collectors

• Flow Processors

• QFlow Collectors

If you are upgrading STRM systems in an HA deployment, you must upgrade in 
the primary system before upgrading the associated secondary system. The 
primary host must be the active system in your deployment. If the secondary host 
displays active, the upgrade of the primary host to STRM 2010.0.r2 cancels. For 
more information on system and license management, see the STRM 
Administration Guide.

CAUTION
Disk replication and failovers are disabled until the primary and secondary hosts 
synchronize and the needs upgrade or failed status is cleared from the 
secondary host.

During the upgrade of any secondary host, the System and License Management 
screen changes the status of the secondary host to upgrading. After the upgrade 
of the secondary host is complete, you must restore the configuration of the 
secondary host. For more information on restoring a failed host, see the STRM 
Administration Guide.

You are now ready to upgrade to STRM 2010.0.r2.

Upgrading 
Appliances to 
STRM 2010.0.r2 
Using CentOS

You should always back up your data before you begin a software upgrade. For 
more information on backup and recovery, see the Managing Backup and 
Recovery chapter in the STRM Administration Guide.

To upgrade your appliances to STRM 2010.0.r2:

Step 1 Log in as root. 

Step 2 To create the /store/iso folder:
mkdir /store/iso

Step 3 Go to the Juniper customer support website to access the STRM 2010.0.r2 
download: 
www.juniper.net/support/ 

Step 4 Copy the file to the /store/iso folder on your system. 
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Step 5 To mount the ISO: 
mount –o loop /store/iso/<ISO-filename> /media/cdrom 

Step 6 Type the setup command: 

/media/cdrom/setup 

The End User License Agreement (EULA) appears.

Step 7 Read the information in the window. Press the spacebar to advance each window 
until you have reached the end of the document. Type yes to accept the 
agreement, and then press Enter.
The following prompt appears:
About to upgrade your STRM from 2009.2-<build> to 
2010.0.r2-<build>. Continue (Y/[N])? 

Step 8 To continue, type Y. 

The following message appears during the upgrade. 
WARNING: This release offers new and updated functionality that 
results in a change to our data collection process. Upgrading 
your system will result in some data (as defined below) being 
removed from your system. Removed data cannot be recovered once 
the upgrade is in process and will no longer be available by the 
system. If you require this data, back up the data before 
continuing with the upgrade process.

The upgrade will remove the following data:

- Sentries: /store/sentry that uses XX(K/M/G) of disk space. 
- Network Surveillance Views: /store/db that uses XX(K/M/G) of 
disk space.
- Offenses: Current offenses will not be lost during the 
upgrade, however all open offenses will be closed. 

For more information, see the Upgrade Guide and Release Notes.

Are you sure you want to proceed with the upgrade (Y/[N])?
NOTE: Data will only be deleted when you perform the upgrade.

Step 9 Type Y to continue the upgrade.

The upgrade to STRM 2010.0.r2 is now in progress. You must not cancel or turn 
off the appliance when an upgrade is in process.

This process can take an extended period to complete. To save storage space, the 
installation may prompt you to delete patch files that are no longer required by the 
system.

The following message appears: 
WARNING: Carefully review the Upgrade Guide before selecting one of the 
following options:
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1. Reset the system to the default template (Recommended). This removes 
all previous rules, reports, searches, and tuning. Selecting this 
option requires you to recreate custom rules, searches, reports, and 
retune the system. 

2. Apply the new default template over the current configuration with 
default rules and new time series accumulations enabled without 
modifying existing rules or searches. This option resets default 
reports and overwrites any changes the user has made to default 
reports. User created reports are not affected. Selecting this option 
can introduce duplicate rules and will require significant tuning, 
however all new reports and accumulations are available. Reports that 
required time series data may need to be recreated.

3. Apply the new template over the current configuration and enable 
only new flow rules, common rules, and specific event rules that are 
required for new reports or detection of activity from flow data which 
was removed during the upgrade. Existing rules and saved searches are 
not modified. This option resets default reports and overwrites any 
changes the user has made to default reports. User created reports are 
not affected. Some reports that required time series data may need to 
be recreated.

4. Apply only new rules and enable a minimal set of these rules. New 
saved searches and reports are not installed. Existing saved searches 
and reports are not modified. Some reports that required time series 
data may need to be recreated. You should carefully evaluate newly 
installed common and flow rules that are disabled by default and enable 
appropriate rules.

Enter a selection (1-4) or press enter to see the options again:
Is this correct? [y/n]:

Step 10 Read these options carefully before upgrading your tuning template. Your 
selection affects data and customization retention. For more information, see 
Upgrading Your Tuning Template.

Step 11 Type the number for your template option selection and type Y to confirm your 
selection. 

Wait for STRM to complete the upgrade. This process can take several minutes, 
depending on your system. 

CAUTION
You must not cancel or turn off the appliance when an upgrade is in progress.

Step 12 To restart STRM and complete the upgrade process:
reboot

Step 13 Log in as root.

The following message appears:
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This server was upgraded to STRM 2010.0.r2<build> on <date>.

Clearing the Cache If you have trouble accessing the STRM user interface after you upgrade to STRM 
2010.0.r2, we recommend that you clear your Java cache. Before you clear the 
cache, make sure you have only one instance of your browser open. If you have 
multiple versions of your browser open, the cache fails to clear.

The Java Runtime Environment must be installed on the desktop system you use 
to view STRM. You can download Java version 1.6.0_u24 at the following 
website: http://java.com/. 

To clear your cache and access the STRM interface:

Step 1 Clear your Java cache:

a    On your desktop, select Start > Control Panel. 
The Control Panel appears:

b    Double-click the Java icon.

The Java Control Panel appears. 

If you are using Microsoft Windows 7 as your operating system, the Java icon 
may be located under the Programs section, depending on how your Control 
Panel is configured to display features.

c    In the Temporary Internet Files section, click View.

The Java Cache Viewer appears.

d    Select all STRM Deployment Editor entries. 

e    Click the delete icon . 

f    Click Close.

g    Click OK.

Step 2 Open your Web browser.

Step 3 Clear the cache of your Web browser:

a    If you are using Internet Explorer 7.0 or 8.0, select Tools > Delete Browsing 
History.

b    If you are using Internet Explorer 9.0, click the gear icon in right corner of the 
browser window, select Internet Options > General, and then click Delete in 
the Browsing History section.

c    If you are using Mozilla Firefox 3.6.x and above, select Tools > Clear Recent 
History > Clear Now.

If you are using Mozilla Firefox, you must clear the cache in Internet Explorer as 
well as in Mozilla Firefox. 

Step 4 Log in to STRM.
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For more information on accessing and using STRM, see the STRM Users Guide 
or the STRM Administration Guide. 

After You Upgrade After you upgrade, make sure you have completed the following steps:

• Reconnect any off-site components using the deployment editor to maintain 
forwarded event and flow data between deployments. For more information on 
using the deployment editor, see the STRM Administration Guide. 

• Connect your QFlow Collectors to the proper Event Collector using the 
deployment editor. For more information on using the deployment editor, see 
the STRM Administration Guide. 

• Update your DSMs, scanners, protocols, and Juniper NSM plug-in to STRM 
2010.0.r2 versions. If your deployment includes DSMs or scanners installed 
using an .rpm file, the following error appears in the log files after you upgrade 
your system to STRM 2010.0.r2:
ErrorStream ExecuteAutoUpdate-Deploy: Can't load 
'/opt/qradar/perl5libs/lib/site_perl/5.6.1/i686-linux-thread-
multi/auto/XML/Parser/Expat/Expat.so' for module XML::Parser 
::Expat:/opt/qradar/perl5libs/lib/site_perl/5.6.1/i686-linux- 
thread-multi/auto/XML/Parser/Expat/Expat.so: wrong ELF class: 
ELFCLASS32 at/usr/lib64/perl5/5.8.8/x86_64-linux-thread-multi 
/DynaLoader.pm line 230 

This error does not affect the upgrade process or system functionality and can 
be ignored. For more information, go to the Juniper customer support website. 

• Evaluate your system to determine if any of the following rules or reports are 
required. If any of the following reports are required for your system, you must 
enable the associated rule:

Table 1-3   Rules Required for Default Reports 

Rule 
Number Rule Description Report Name
1279 Compliance: Compliance Events 

Become Offenses
Systems and Users Involved in 
Compliance Offenses

1296 System: Device Stopped Sending 
Events

PCI 10 - Audit of Data

1296 System: Device Stopped Sending 
Events

PCI 10 - Audit of Data (Weekly) 

1296 System: Device Stopped Sending 
Events

PCI 10 - Audit of Data (Monthly) 

1302 Vulnerabilities: Vulnerability 
Reported by Scanner

Systems and Users Involved in 
Compliance Offenses 

1346 Compliance: Excessive Failed 
Logins to Compliance IS

Systems and Users Involved in 
Compliance Offenses 

1427 Authentication: Login Failure to 
Disabled Account

Weekly Login Failures to Disabled 
or Enabled Accounts
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For more information on enabling rules or reports, see the STRM Administration 
Guide. 

1428 Authentication: Login Failure to 
Expired Account 

Weekly Login Failures to Disabled 
or Enabled Accounts

1553 Compliance: Multiple Failed Logins 
to a Compliance Asset

Systems and Users Involved in 
Compliance Offenses

1559 Compliance: Traffic from Untrusted 
Network to Trusted Network

Systems and Users Involved in 
Compliance Offenses 

1560 Compliance: Traffic from DMZ to 
Internal Network

Systems and Users Involved in 
Compliance Offenses 

1562 Compliance: Configuration Change 
Made to Device in Compliance 
network

Systems and Users Involved in 
Compliance Offenses

1564 Compliance: Auditing Services 
Changed on Compliance Host 

Systems and Users Involved in 
Compliance Offenses 

Table 1-3   Rules Required for Default Reports (continued)

Rule 
Number Rule Description Report Name
DO14102011-A Release 2010.0 Maintenance Release 2
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